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1 Product introduction

● Product comparison

● Product views

● Product hardware setup and software installation

For more information:

Go to www.hp.com/support/ljM201, www.hp.com/support/ljM202.

HP's all-inclusive help for the product includes the following information:

● Install and configure

● Learn and use

● Solve problems

● Download software updates

● Join support forums

● Find warranty and regulatory information
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Product comparison
Model name

Product number

 M201n

CF455A

M202n

C6N20A

M201dw

CF456A

M202dw

C6N21A

M201d

CF466A

M202d

CF467A

Product dimensions Height 251 mm 
(9.9 in)

251 mm 
(9.9 in)

251 mm 
(9.9 in)

251 mm 
(9.9 in)

251 mm 
(9.9 in)

251 mm 
(9.9 in)

 Depth 251 mm 
(9.9 in)

242 mm 
(9.5 in)

281 mm 
(11.1 in)

281 mm 
(11.1 in)

281 mm 
(11.1 in)

281 mm 
(11.1 in)

 Width 379 mm 
(14.9 in)

379 mm 
(14.9 in)

384 mm 
(15.1 in)

384 mm 
(15.1 in)

384 mm 
(15.1 in)

384 mm 
(15.1 in)

 Weight, with toner 
cartridge

5.9 kg 
(13 lb)

5.9 kg 
(13 lb)

6.6 kg 
(14.5 lb)

6.6 kg 
(14.5 lb)

6.6 kg 
(14.5 lb)

6.6 kg 
(14.5 lb)

Paper handling Priority input tray (Tray 
1, 10-sheet capacity)

 Main input tray (Tray 2, 
250-sheet capacity)

 Standard output bin 
(150-sheet capacity)

 Automatic duplex 
printing

  

Supported operating 
systems

Windows XP, 32-bit, SP2 
and greater

 Windows XP, 64-bit, SP2 
and greater, print-driver 
only

 Windows Vista, 32-bit 
and 64-bit

 Windows 7, 32-bit and 
64-bit

 Windows 8, 32-bit and 
64-bit

 Windows 8.1, 32-bit and 
64-bit

 Windows 2003 Server 
32-bit, SP1 and higher, 
print driver only

 Windows 2003 Server 
64-bit, SP1 and higher, 
print driver only

 Windows 2003 Server, 
Standard Edition and 
Enterprise Edition, print 
driver only

 Windows 2003 R2 Server 
32-bit, Standard and 
Enterprise editions, print 
driver only
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Model name

Product number

 M201n

CF455A

M202n

C6N20A

M201dw

CF456A

M202dw

C6N21A

M201d

CF466A

M202d

CF467A

 Windows 2003 R2 Server 
64-bit, Standard and 
Enterprise editions, print 
driver only

 Windows 2008 Server ,
32-bit and 64-bit, (SP1 
and higher) print driver 
only

 Windows 2008 R2 Server 
64-bit, SP1, print driver 
only

 Windows 2008 R2 Server 
64-bit, Standard and 
Enterprise editions, print 
driver only

 Windows 2012 Server, 
print driver only

 Windows 2012 R2 Server 
64-bit, print driver only

 Windows 2012 Server 
64-bit, print driver only

 Mac OS X v10.7 – v10.9

Supported print drivers HP PCL6 discrete print 
driver

This driver is included on 
the in-box CD as the 
default print driver.

 HP UPD PCL5c print 
driver

Available for download

 HP UPD PCL6 print driver

Available for download

 HP UPD PS print driver

Available for download

Connectivity Hi-Speed USB 2.0

10/100 Ethernet LAN 
connection

  

Wireless network 
connection

    

Memory 128 MB RAM
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Model name

Product number

M201n

CF455A

M202n

C6N20A

M201dw

CF456A

M202dw

C6N21A

M201d

CF466A

M202d

CF467A

Control-panel display 2-line LCD

Print Prints 25 pages per 
minute (ppm) on A4-size 
paper and 26 ppm on 
Letter-size paper

Power consumption, electrical specifications, and acoustic emissions
See www.hp.com/support/ljM201, www.hp.com/support/ljM202 for current information.

CAUTION: Power requirements are based on the country/region where the product is sold. Do not convert 
operating voltages. This will damage the product and void the product warranty.

Operating-environment specifications

Environment Recommended Allowed

Temperature 17° to 25°C (62.6° to 77°F) 15° to 30°C (59° to 86°F)

Relative humidity 30% to 70% relative humidity (RH) 10% to 80% RH
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Product views
● Product front view

● Product back view

● Control-panel view

Product front view

1
6

3

2

4

5

1 Output bin

2 Control panel (tilts up for easier viewing)

3 Power on/off button

4 Main input tray (Tray 2)

5 Priority input tray (Tray 1)

6 Handle for opening the top cover (access to the toner cartridge and for clearing jams)
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Product back view

1 2

4

3

6

5
M201d, M201dw
M202d, M202dw

M201n
M202n

1 Rear door (access for clearing jams, duplex models only)

2 Hi-Speed USB 2.0

3 Ethernet port (network and wireless models only)

4 Power connection

5 Product number and serial number label

6 Slot for cable-type security lock
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Control-panel view

4

3

2

56

10

9

8

7

1

1 LCD display Provides textual information, such as product status and configuration menus

2 Power on/off button Turns the product on or off. The button illuminates when the product is on.

3 Left and right arrow buttons Moves the cursor or scrolls through menu options

4 Cancel button Clears settings, cancels the current job, or exits the current menu

5 OK button Confirms a setting or an action to proceed

6 Back button Returns to the previous screen

7 ePrint button Opens the Web Services menu (network and wireless models only)

NOTE: The ePrint button is non-functional on M201d and M202d models.

8 Wireless button and light, dw 
models only

Provides access to the Wireless menu and wireless status information. When the product is 
connected to a wireless network, this button illuminates.

9 Attention light Indicates the product has an error, a tray is empty, or other condition requiring attention

10 Ready light Indicates the product is ready
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Product hardware setup and software installation
For basic setup instructions, see the Hardware Installation Guide that came with the product. For additional 
instructions, go to HP support on the Web.

Go to www.hp.com/support/ljM201, www.hp.com/support/ljM202 for HP's all-inclusive help for the product. 
Find the following support:

● Install and configure

● Learn and use

● Solve problems

● Download software updates

● Join support forums

● Find warranty and regulatory information
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2 Paper trays

● Supported paper sizes and types

● Load the priority input tray (Tray 1)

● Load the main input tray (Tray 2)

For more information:

Go to www.hp.com/support/ljM201, www.hp.com/support/ljM202.

HP's all-inclusive help for the product includes the following information:

● Install and configure

● Learn and use

● Solve problems

● Download software updates

● Join support forums

● Find warranty and regulatory information
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Supported paper sizes and types
● Supported paper sizes

● Supported paper types

Supported paper sizes

NOTE: To obtain the best results, select the correct paper size and type in the print driver before printing.

Size Dimensions Priority input tray 
(Tray 1)

Main input tray (Tray 
2)

Auto duplex

Letter 216 x 279 mm (8.5 x 11 in)

Legal 216 x 356 mm (8.5 x 14 in)

Executive 184 x 267 mm (7.3 x 10.5 in)  

Oficio 8.5 x 13 216 x 330 mm (8.5 x 13 in)

4 x 6 102 x 152 mm (4 x 6 in)   

5 x 8 127 x 203 mm (5 x 8 in)  

A4 210 x 297 mm (8.3 x 11.7 in)

A5 148 x 210 mm (5.8 x 8.3 in)  

A6 105 x 148 mm (4.1 x 5.8 in)   

B5 (JIS) 182 x 257 mm (7.2 x 10.1 in)  

B6 (JIS) 129 x 182 mm (5.1 x 7.2 in)   

10 x 15cm 100 x 150 mm (3.9 x 5.9 in)   

Oficio 216 x 340 mm 216 x 340 mm (8.5 x 13.4 in)

16K 195 x 270 mm (7.7 x 10.6 in)  

16K 184 x 260 mm (7.2 x 10.3 in)  

16K 197 x 273 mm (7.8 x 10.8 in)  

Japanese Postcard

Postcard (JIS)

100 x 148 mm (3.9 x 5.8 in)   

Double Japan Postcard 
Rotated

Double Postcard (JIS)

200 x 148 mm (7.9 x 5.8 in)  

Envelope #10 105 x 241 mm (4.1 x 9.5 in)  
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Size Dimensions Priority input tray 
(Tray 1)

Main input tray (Tray 
2)

Auto duplex

Envelope Monarch 98 x 191 mm (3.9 x 7.5 in)  

Envelope B5 176 x 250 mm (6.9 x 9.8 in)  

Envelope C5 162 x 229 mm (6.4 x 9 in)  

Envelope DL 110 x 220 mm (4.3 x 8.7 in)  

Custom 76 x 127 mm to 216 x 356 mm (3 x 5 in to 
8.5 x 14 in)

  

ENWW Supported paper sizes and types 11



Supported paper types

NOTE: To obtain the best results, select the correct paper size and type in the print driver before printing.

Type Single-sided or manual duplex Auto duplex

Plain

HP EcoSMART Lite

Light 60–74g

Intermediate 85–95g

Midweight 96–110g

Heavy 111–130g  

Extra Heavy 131–175g  

Transparency  

Labels  

Letterhead

Envelope  

Preprinted

Prepunched

Colored

Bond

Recycled

Rough  

Vellum  
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Load the priority input tray (Tray 1)
NOTE: When adding new paper, make sure to remove all of the paper from the input tray and straighten the 
stack. Do not fan the paper. This reduces jams by preventing multiple sheets of paper from feeding through 
the product at one time. Use paper that is not wrinkled, folded, or damaged.

1. Load the paper face-up with the top forward in 
the input tray.

The orientation of the paper in the tray varies 
depending on the type of print job. For additional 
information, see Table 2-1 Tray 1 paper 
orientation on page 13.

 

2. Adjust the paper guides until they are snug 
against the paper.

 

Table 2-1  Tray 1 paper orientation

Paper type Duplex mode How to load paper

Preprinted or letterhead 1-sided printing or manual 2-sided 
printing

Face-up

Top edge leading into the product
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Table 2-1  Tray 1 paper orientation (continued)

Paper type Duplex mode How to load paper

Prepunched 1-sided printing or manual 2-sided 
printing

Face-up

Holes toward the left side of the product

Envelopes 1-sided printing Face-up

Top edge toward the right of the tray, postage end entering 
the product last
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Load the main input tray (Tray 2)
NOTE: When adding new paper, make sure to remove all of the paper from the input tray and straighten the 
stack. Do not fan the paper. This reduces jams by preventing multiple sheets of paper from feeding through 
the product at one time. Use paper that is not wrinkled, folded, or damaged.

1. Open the dust cover.  

2. Load the paper into the tray. Make sure that the 
paper fits under the tabs and below the 
maximum-height indicators.

The orientation of the paper in the tray varies 
depending on the type of print job. For additional 
information, see Table 2-2 Tray 2 paper 
orientation on page 17.
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3. Adjust the paper guides until they are snug 
against the paper.

 

4. Close the dust cover.  
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Table 2-2  Tray 2 paper orientation

Paper type Duplex mode How to load paper

Preprinted or letterhead 1-sided printing or 2-sided printing Face-up

Top edge leading into the product

Prepunched 1-sided printing or 2-sided printing Face-up

Holes toward the left side of the product
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3 Parts, supplies, and accessories

● Order parts, accessories, and supplies

● Replace the toner cartridge

For more information:

Go to www.hp.com/support/ljM201, www.hp.com/support/ljM202.

HP's all-inclusive help for the product includes the following information:

● Install and configure

● Learn and use

● Solve problems

● Download software updates

● Join support forums

● Find warranty and regulatory information
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Order parts, accessories, and supplies
Ordering

Order supplies and paper www.hp.com/go/suresupply

Order genuine HP parts or accessories www.hp.com/buy/parts

Order through service or support providers Contact an HP-authorized service or support provider.

Order using the HP Embedded Web Server (EWS) To access, in a supported Web browser on your computer, enter 
the product IP address or host name in the address/URL field. The 
EWS contains a link to the HP SureSupply Web site, which provides 
options for purchasing Original HP supplies.

Supplies and accessories

Item Description Part number

HP 83A Toner Cartridge Replacement toner cartridge CF283A

HP 83X Toner Cartridge High-capacity replacement toner cartridge CF283X

HP 88A Toner Cartridge Replacement toner cartridge for China and India 
only

CC388A

USB cable 2-meter standard USB-compatible device 
connector

C6518A
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Replace the toner cartridge
When a toner cartridge approaches the end of useful life, the product displays a prompt to order a 
replacement. Printing can continue with the current cartridge until redistributing the toner no longer yields 
acceptable print quality.

A second message displays on the control panel when the toner cartridge reaches the “very low” state.

1. Open the top cover.  

2. Remove the toner cartridge.  
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3. Remove the new toner cartridge from the bag. 
Place the used toner cartridge in the bag for 
recycling.

 

4. Grasp both sides of the toner cartridge and 
distribute the toner by gently rocking the 
cartridge.

CAUTION: Do not touch the shutter or the 
surface of the roller.

 

5. Bend the tab on the left side of the cartridge until 
the tab breaks loose. Pull the tab until all the 
tape is removed from the cartridge. Place the tab 
and tape in the toner cartridge box to return for 
recycling.
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6. Align the toner cartridge with the tracks inside 
the product, and then insert the toner cartridge 
until it is firmly seated.

 

7. Close the top cover.  
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4 Print

● Print tasks (Windows)

● Print tasks (Mac OS X)

● Set up HP Wireless Direct Printing (network and wireless models only)

● Mobile printing (network and wireless models only)

For more information:

Go to www.hp.com/support/ljM201, www.hp.com/support/ljM202.

HP's all-inclusive help for the product includes the following information:

● Install and configure

● Learn and use

● Solve problems

● Download software updates

● Join support forums

● Find warranty and regulatory information
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Print tasks (Windows)
● How to print (Windows)

● Automatically print on both sides (Windows)

● Manually print on both sides (Windows) 

● Print multiple pages per sheet (Windows)

● Select the paper type (Windows)

● Additional print tasks

How to print (Windows)
The following procedure describes the basic printing process for Windows.

1. From the software program, select the Print option.

2. Select the product from the list of printers. To change settings, click or tap the Properties or 
Preferences button to open the print driver.

NOTE: The name of the button varies for different software programs.
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3. Click or tap the tabs in the print driver to configure the available options. For example, set the paper 
orientation on the Finishing tab, and set the paper source, paper type, paper size, and quality settings 
on the Paper/Quality tab.

4. Click or tap the OK button to return to the Print dialog box. Select the number of copies to print from 
this screen.

5. Click or tap the OK button to print the job.

ENWW Print tasks (Windows) 27



Automatically print on both sides (Windows)
Use this procedure for products that have an automatic duplexer installed. If the product does not have an 
automatic duplexer installed, or to print on paper types that the duplexer does not support, you can print on 
both sides manually.

1. From the software program, select the Print option.

2. Select the product from the list of printers, and then click or tap the Properties or Preferences button to 
open the print driver.

NOTE: The name of the button varies for different software programs.

3. Click or tap the Finishing tab.

4. Select the Print on both sides check box. Click the OK button to close the Document Properties dialog 
box.

5. In the Print dialog box, click the OK button to print the job.
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Manually print on both sides (Windows) 
Use this procedure for products that do not have an automatic duplexer installed or to print on paper that the 
duplexer does not support.

1. From the software program, select the Print option.

2. Select the product from the list of printers, and then click or tap the Properties or Preferences button to 
open the print driver.

NOTE: The name of the button varies for different software programs.

3. Click or tap the Finishing tab.

4. Select the Print on both sides (manually) check box. Click the OK button to print the first side of the job.

5. Retrieve the printed stack from the output bin, and place it in Tray 1.

6. If prompted, touch the appropriate control panel button to continue.
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Print multiple pages per sheet (Windows)
1. From the software program, select the Print option.

2. Select the product from the list of printers, and then click or tap the Properties or Preferences button to 
open the print driver.

NOTE: The name of the button varies for different software programs.

3. Click or tap the Finishing tab.

4. Select the number of pages per sheet from the Pages per sheet drop-down list.

5. Select the correct Print page borders, Page order, and Orientation options. Click the OK button to close 
the Document Properties dialog box.

6. In the Print dialog box, click the OK button to print the job.
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Select the paper type (Windows)
1. From the software program, select the Print option.

2. Select the product from the list of printers, and then click or tap the Properties or Preferences button to 
open the print driver.

NOTE: The name of the button varies for different software programs.

3. Click or tap the Paper/Quality tab.

4. From the Paper type drop-down list, click the More... option.

5. Expand the list of Type is: options.

6. Expand the category of paper types that best describes your paper.

7. Select the option for the type of paper you are using, and then click the OK button.

8. Click the OK button to close the Document Properties dialog box. In the Print dialog box, click the OK 
button to print the job.

Additional print tasks
Go to www.hp.com/support/ljM201, www.hp.com/support/ljM202.

Instructions are available for performing specific print tasks, such as the following:

● Create and use printing shortcuts or presets

● Select the paper size, or use a custom paper size

● Select the page orientation

● Create a booklet

● Scale a document to fit a specific paper size

● Print the first or last pages of the document on different paper

● Print watermarks on a document
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Print tasks (Mac OS X)
● How to print (OS X)

● Automatically print on both sides (OS X)

● Manually print on both sides (OS X)

● Print multiple pages per sheet (OS X)

● Select the paper type (OS X)

● Additional print tasks

How to print (OS X)
The following procedure describes the basic printing process for OS X.

1. Click the File menu, and then click the Print option.

2. Select the product.

3. Click Show Details, and then select other menus to adjust the print settings.

4. Click the Print button.

Automatically print on both sides (OS X)

NOTE: This information applies to products that include an automatic duplexer.

NOTE: This feature is available if you install the HP print driver. It might not be available if you are using 
AirPrint.

1. Click the File menu, and then click the Print option.

2. Select the product.

3. Click Show Details, and then click the Layout menu.

4. Select a binding option from the Two-Sided drop-down list.

5. Click the Print button.

Manually print on both sides (OS X)

NOTE: This feature is available if you install the HP print driver. It might not be available if you are using 
AirPrint.

1. Click the File menu, and then click the Print option.

2. Select the product.

3. Click Show Details, and then click the Manual Duplex menu.

4. Click the Manual Duplex box, and select a binding option.

5. Click the Print button.

6. Go to the product, and remove any blank paper that is in Tray 1.
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7. Retrieve the printed stack from the output bin and place it with the printed-side facing down in the input 
tray.

8. If prompted, touch the appropriate control panel button to continue.

Print multiple pages per sheet (OS X)
1. Click the File menu, and then click the Print option.

2. Select the product.

3. Click Show Details, and then click the Layout menu.

4. From the Pages per Sheet drop-down list, select the number of pages that you want to print on each 
sheet.

5. In the Layout Direction area, select the order and placement of the pages on the sheet.

6. From the Borders menu, select the type of border to print around each page on the sheet.

7. Click the Print button.

Select the paper type (OS X)
1. Click the File menu, and then click the Print option.

2. Select the product.

3. Click Show Details, and then click the Media & Quality menu or the Paper/Quality menu.

4. Select a type from the Media-type drop-down list.

5. Click the Print button.

Additional print tasks
Go to www.hp.com/support/ljM201, www.hp.com/support/ljM202.

Instructions are available for performing specific print tasks, such as the following:

● Create and use printing shortcuts or presets

● Select the paper size, or use a custom paper size

● Select the page orientation

● Create a booklet

● Scale a document to fit a specific paper size

● Print the first or last pages of the document on different paper

● Print watermarks on a document
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Set up HP Wireless Direct Printing (network and wireless models 
only)

NOTE: This feature is available with wireless models only and the product might require a firmware update 
to use this feature.

The HP Wireless Direct Printing feature lets you print from your wireless mobile device directly to an 
HP Wireless Direct-enabled product without requiring connection to an established network or the Internet. 
Use HP Wireless Direct to print wirelessly from the following devices:

● iPhone, iPad, or iTouch using Apple AirPrint or the HP ePrint mobile app

● Mobile devices that run Android or Symbian using the HP ePrint Home & Biz application

● Any Wi-Fi capable computer with any operating system.

For more information on HP Wireless Direct, go to www.hp.com/go/wirelessprinting, and then click HP 
Wireless Direct.

To set up HP Wireless Direct from the control panel, complete the following steps:

1. At the product control panel, press the OK button to open the menus.

2. Use the arrow buttons to open the following menus:

● Network Setup

● Wireless Menu

● Wireless Direct

3. Select the On option, and then press the OK button. The product saves the setting and then returns the 
control panel to the Wireless Direct menu.
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Mobile printing (network and wireless models only)
HP offers multiple Mobile and ePrint solutions to enable wireless printing to an HP printer from a laptop, 
tablet, smartphone, or other mobile device. To determine the best choice, go to www.hp.com/go/
LaserJetMobilePrinting (English only).

● HP ePrint via email

● HP ePrint software

● AirPrint

HP ePrint via email
Use HP ePrint to print documents by sending them as an email attachment to the product's email address 
from any email enabled device.

To use HP ePrint, the product must meet these requirements:

● The product must be connected to a wired network and have Internet access.

● HP Web Services must be enabled on the product, and the product must be registered with 
HP Connected.

1. On the product control panel, press the OK button.

2. Scroll to the HP Web Services menu, and press the OK button.

3. Scroll to the Print Information Sheet option, and press the OK button.

The information page contains the printer code that you use to register your HP product at 
HP Connected.

4. Go to www.hpconnected.com to create an HP ePrint account and complete the setup process.

For more information, go to www.hp.com/support to review additional support information for your product.

HP ePrint software
The HP ePrint software makes it easy to print from a Windows or Mac desktop or laptop computer to any HP 
ePrint-capable product. This software makes it easy to find HP ePrint-enabled products that are registered to 
your HP Connected account. The target HP printer can be located in the office or at locations across the globe.

● Windows: After installing the software, open the Print option from within your application, and then 
select HP ePrint from the installed printers list. Click the Properties button to configure print options.

● Mac: After installing the software, select File, Print, and then select the arrow next to PDF (in the 
bottom left of the driver screen). Select HP ePrint.

For Windows, the HP ePrint software supports TCP/IP printing to local network printers on the network (LAN 
or WAN) to products that support UPD PostScript®.

Windows and Mac both support IPP printing to LAN or WAN network-connected products that support ePCL.

Windows and Mac also both support printing PDF documents to public print locations and printing using HP 
ePrint via email through the cloud.

Go to www.hp.com/go/eprintsoftware for drivers and information.
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NOTE: The HP ePrint software is a PDF workflow utility for Mac, and is not technically a print driver.

NOTE: HP ePrint Software does not support USB printing.

AirPrint
Direct printing using Apple’s AirPrint is supported for iOS 4.2 or later. Use AirPrint to print directly to the 
product from an iPad, iPhone (3GS or later), or iPod touch (third generation or later) in the following 
applications:

● Mail

● Photos

● Safari

● iBooks

● Select third-party applications

To use AirPrint, the product must be connected to the same wireless network as the Apple device. For more 
information about using AirPrint and about which HP products are compatible with AirPrint, go to the support 
Web site for this product:

www.hp.com/support/ljM201, www.hp.com/support/ljM202

NOTE: AirPrint does not support USB connections.
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5 Manage the product

● Change the product connection type (Windows)

● Advanced configuration with HP Embedded Web Server (EWS) and HP Device Toolbox (Windows)

● Advanced configuration with HP Utility for Mac OS X

● Configure IP network settings

● HP Web Jetadmin

● Product security features

● Economy settings

● Update the firmware

For more information:

Go to www.hp.com/support/ljM201, www.hp.com/support/ljM202.

HP's all-inclusive help for the product includes the following information:

● Install and configure

● Learn and use

● Solve problems

● Download software updates

● Join support forums

● Find warranty and regulatory information
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Change the product connection type (Windows)
If you are already using the product and you wish to change the way it is connected, use the Reconfigure your 
HP Device shortcut on your computer desktop to change the connection. For example, you can reconfigure 
the product to use a different wireless address, to connect to a wired or wireless network, or change from a 
network connection to a USB connection. You can change the configuration without inserting the product CD. 
After you select the type of connection you wish to make, the program goes directly to the portion of the 
product setup procedure that needs to change.
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Advanced configuration with HP Embedded Web Server (EWS) 
and HP Device Toolbox (Windows)

Use the HP Embedded Web Server to manage printing functions from your computer instead of the product 
control panel.

● View product status information

● Determine the remaining life for all supplies and order new ones

● View and change tray configurations

● View and change the product control-panel menu configuration

● View and print internal pages

● Receive notification of product and supplies events

● View and change network configuration

The HP Embedded Web Server works when the product is connected to an IP-based network. The HP 
Embedded Web Server does not support IPX-based product connections. You do not have to have Internet 
access to open and use the HP Embedded Web Server.

When the product is connected to the network, the HP Embedded Web Server is automatically available.

NOTE: HP Device Toolbox is available only if you performed a full installation when you installed the 
product. Depending on how the product is connected, some features might not be available.

NOTE: The HP Embedded Web Server is not accessible beyond the network firewall.

Open the HP Embedded Web Server (EWS) from the Start menu

1. Click the Start button, and then click the Programs item.

2. Click your HP product group, and then click the HP Device Toolbox item.

Open the HP Embedded Web Server (EWS) from a Web browser

1. Print a configuration page, and locate the IP address.

a. On the control panel, press the OK button.

b. Scroll to the Reports menu, and then press the OK button.

c. Scroll to the Configuration Report, and then press the OK button to print the report.

2. Open a Web browser, and in the address line, type the IP address as it displays on the product control 
panel. Press the Enter key on the computer keyboard. The EWS opens.
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Tab or section Description

Home tab

Provides product, status, and 
configuration information.

● Device Status: Shows the product status and shows the approximate percent life 
remaining of HP supplies.

● Supplies Status: Shows the approximate percent life remaining of HP supplies. Actual 
supply life remaining can vary. Consider having a replacement supply available to install 
when print quality is no longer acceptable. The supply does not need to be replaced 
unless the print quality is no longer acceptable.

● Device Configuration: Shows the information found on the product configuration page.

● Network Summary: Shows the information found on the product network configuration 
page.

● Reports: Print the configuration and supplies status pages that the product generates.

● Event Log: Shows a list of all product events and errors.

System tab

Provides the ability to configure the 
product from your computer.

● Device Information: Provides basic product and company information.

● Paper Setup: Change the default paper-handling settings for the product.

● Print Quality: Change the default print-quality settings for the product.

● EcoSMART Console: Change the default times for entering Sleep mode or Auto Power 
Down mode. Configure which events cause the product to wake.

● Paper Types: Configure print modes that correspond to the paper types that the product 
accepts.

● System Setup: Change the system defaults for the product.

● Service: Perform the cleaning procedure on the product.

● Save and Restore: Save the current settings for the product to a file on the computer. Use 
this file to load the same settings onto another product or to restore these settings to 
this product at a later time.

● Administration: Set or change the product password. Enable or disable product features.

NOTE: The System tab can be password-protected. If this product is on a network, always 
consult with the administrator before changing settings on this tab.

Print tab

Provides the ability to change default 
print settings from your computer.

● Printing: Change the default product print settings, such as number of copies and paper 
orientation. These are the same options that are available on the control panel.

● PCL5c: View and change the PCL5c settings.

● PostScript: Turn off or on the Print PS Errors feature.

Networking tab

(Network-connected products only)

Provides the ability to change 
network settings from your 
computer.

Network administrators can use this tab to control network-related settings for the product 
when it is connected to an IP-based network. It also allows the network administrator to set up 
Wireless Direct functionality. This tab does not appear if the product is directly connected to a 
computer.

HP Web Services tab Use this tab to set up and use various Web tools with the product.
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Advanced configuration with HP Utility for Mac OS X
Use the HP Utility to check product status or to view or change product settings from your computer.

You can use the HP Utility when the product is connected with a USB cable or is connected to a TCP/IP-based 
network.

Open HP Utility
1. At the computer, open the System Preferences menu, and then click Print & Fax, Print & Scan, or 

Printers & Scanners.

2. Select the product in the list.

3. Click the Options & Supplies button.

4. Click the Utility tab.

5. Click the Open Printer Utility button.

HP Utility features
The HP Utility toolbar includes these items:

● Devices: Click this button to show or hide Mac products found by the HP Utility.

● All Settings: Click this button to return to the HP Utility main view.

● HP Support: Click this button to open a browser and go to the HP support Web site.

● Supplies: Click this button to open the HP SureSupply Web site.

● Registration: Click this button to open the HP registration Web site.

● Recycling: Click this button to open the HP Planet Partners Recycling Program Web site.

HP Utility consists of pages that you open by clicking in the All Settings list. The following table describes the 
tasks that you can perform with HP Utility.

Menu Description

Information And Support ● Supplies Status: Show the product supplies status and provides links for ordering 
supplies online.

● Device Information: Show information about the currently selected product, 
including the product Service ID (if assigned), the firmware version (FW Version), 
the Serial Number, and the IP address.

● File Upload: Transfer files from the computer to the product. You can upload the 
following types of files:

◦ HP LaserJet printer command language (.PRN)

◦ Portable document format (.PDF)
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Menu Description

◦ Postscript (.PS)

◦ Text (.TXT)

● HP Connected: Access the HP Connected Web site.

● Upload Fonts: Upload fonts from your computer to the product.

Printer Settings ● Auto-off: Configure the product to automatically turn off after a period of 
inactivity. You can adjust the number of minutes after which the product turns off.

● Network Settings: Configure the network settings, such as the IPv4 settings, IPv6 
settings, Bonjour settings, and other settings.

● Supplies Management: Configure how the product should behave when supplies 
are nearing the end of their estimated life.

● Trays Configuration: Change paper size and type for each of the trays.

● Additional Settings: Open the HP Embedded Web Server (EWS) for the product.

NOTE: USB connections are not supported.

Information Message Center: Display error events that have occurred with the product.

Fax Settings

(MFP fax models only)

● Basic Fax Settings: Set up the fields in the fax header and configure how the 
product answers incoming calls.

● Junk Fax Blocking: Store the fax numbers you want to block.

● Fax Forwarding: Set up the product to send the incoming faxes to a different 
number.

● Fax Logs: View the logs of all faxes.

● Fax Speed Dials: Add fax numbers to the speed dial list.

Scan Settings

(MFP touchscreen models only)

● Scan to E-mail: Open the HP Embedded Web Server (EWS) page for configuring 
settings for scanning to email.

● Scan to Network Folder: Open the HP Embedded Web Server (EWS) page for 
configuring settings for scanning to a network folder.

NOTE: USB connections are not supported.
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Configure IP network settings
● Printer sharing disclaimer

● View or change network settings

● Rename the product on a network

● Manually configure IPv4 TCP/IP parameters from the control panel

Printer sharing disclaimer
HP does not support peer-to-peer networking, as the feature is a function of Microsoft operating systems and 
not of the HP printer drivers. Go to Microsoft at www.microsoft.com.

View or change network settings
Use the HP Embedded Web Server to view or change IP configuration settings.

1. Print a configuration page, and locate the IP address.

a. On the control panel, press the OK button.

b. Scroll to the Reports menu, and then press the OK button.

c. Scroll to the Configuration Report option, and then press the OK button to print the report.

2. Open a Web browser, and in the address line, type the IP address exactly as it displays on the product 
control panel. Press the Enter key on the computer keyboard. The EWS opens.

3. Click the Networking tab to obtain network information. Change settings as needed.

Rename the product on a network
If you want to rename the product on a network so that it can be uniquely identified, use the HP Embedded 
Web Server.

1. Print a configuration page, and locate the IP address.

a. On the control panel, press the OK button.

b. Scroll to the Reports menu, and then press the OK button.

c. Scroll to the Configuration Report option, and then press the OK button to print the report.

2. Open a Web browser, and in the address line, type the IP address as it displays on the product control 
panel. Press the Enter key on the computer keyboard. The EWS opens.

3. Open the System tab.

4. On the Device Information page, the default product name is in the Device Status field. You can change 
this name to uniquely identify this product.
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NOTE: Completing the other fields on this page is optional.

5. Click the Apply button to save the changes.

Manually configure IPv4 TCP/IP parameters from the control panel
Use the control-panel menus to manually set an IPv4 address, subnet mask, and default gateway.

1. On the product control panel, press the OK button.

2. Open the following menus:

● Network Setup

● IPV4 Config Method

● Manual

3. Use the arrow keys to enter the IP address, and press the OK button. Press the OK button again to 
confirm.

4. Use the arrow keys to enter the subnet mask, and press the OK button. Press the OK button again to 
confirm.

5. Use the arrow keys to enter the default gateway, and press the OK button. Press the OK button again to 
confirm.
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HP Web Jetadmin
HP Web Jetadmin is an award-winning, industry-leading tool for efficiently managing a wide variety of 
networked HP products, including printers, multifunction products, and digital senders. This single solution 
allows you to remotely install, monitor, maintain, troubleshoot, and secure your printing and imaging 
environment — ultimately increasing business productivity by helping you save time, control costs, and 
protect your investment.

HP Web Jetadmin upgrades are periodically made available to provide support for specific product features. 
Go to www.hp.com/go/webjetadmin and click the Self Help and Documentation link to learn more about 
upgrades.
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Product security features
The product supports security standards and recommended protocols that help you keep the product secure, 
protect critical information on your network, and simplify the way you monitor and maintain the product.

For in-depth information about HP's secure imaging and printing solutions, visit www.hp.com/go/
secureprinting. The site provides links to white papers and FAQ documents about security features.

Set or change the product password using the HP Embedded Web Server
Use the HP Embedded Web Server to set a password or change an existing password for a product on a 
network.

1. Print a configuration page, and locate the IP address.

a. On the control panel, press the OK button.

b. Scroll to the Reports menu, and then press the OK button.

c. Scroll to the Configuration Report, and then press the OK button to print the report.

2. Open a Web browser, and in the address line, type the IP address exactly as it displays on the product 
control panel. Press the Enter key on the computer keyboard. The EWS opens.

3. Click the System tab, and click either the Product Security or the Administration link.

NOTE: If a password has previously been set, you are prompted to provide the password. Enter the 
password, and then click the Apply button.

4. Enter the new password in the Password box and in the Confirm Password box.

5. At the bottom of the window, click the Apply button to save the password.

NOTE: For products connected with a USB cable to a Windows computer, use the HP Device Toolbox to 
change the product password:

1. Click the Start button, and then click the Programs item.

2. Click your HP product group, and then click the HP Device Toolbox item.

3. Click the System tab.

4. Click Administration, and locate the area to change the password.
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Economy settings
● Print with EconoMode

● Set the Sleep Delay

● Set the Auto Power Down delay

Print with EconoMode
This product has an EconoMode option for printing drafts of documents. Using EconoMode can use less toner. 
However, using EconoMode can also reduce print quality.

HP does not recommend the full-time use of EconoMode. If EconoMode is used full-time, the toner supply 
might outlast the mechanical parts in the toner cartridge. If print quality begins to degrade and is no longer 
acceptable, consider replacing the toner cartridge.

NOTE: If this option is not available in your print driver, you can set it using the HP Embedded Web Server.

1. From the software program, select the Print option.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. Click the EconoMode check box.

Set the Sleep Delay
1. On the product control panel, press the OK button.

2. Open the following menus:

● System Setup

● Energy Settings

● Sleep/Auto off

● Sleep/Auto off After

3. Select the time for the sleep delay, and then press the OK button.

NOTE: The default value is 15 Minutes.

Set the Auto Power Down delay

NOTE: This setting is not available on all products.

1. On the product control panel, touch the OK button.

2. Open the following menus:

● System Setup

● Energy Settings

● Shut down After
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3. Select the time for the power-down delay.

NOTE: The default value is Never.

4. The product automatically wakes when it receives jobs or when you press a button on the product 
control panel. You can change which events cause the product to wake. Open the following menus:

● System Setup

● Energy Settings

● Sleep/Auto Off

● Wake Events

To turn off a wake event, select the event, and then select the No option.
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Update the firmware
HP offers periodic product updates, new Web Services apps, and new features to existing Web Services apps. 
Follow these steps to update the product firmware for a single product. When you update the firmware, Web 
Service apps will update automatically.

There are two supported methods to perform a firmware update on this product. Use only one of the 
following methods to update the product firmware.

Method one: Update the firmware using the control panel
Use these steps to load the firmware from the control panel (for network-connected products only), and/or 
set the product to automatically load future firmware updates. For USB-connected products, skip to method 
two.

1. Make sure the product is connected to a wired (Ethernet) network with an active Internet connection.

NOTE: The product must be connected to the Internet to update the firmware via a network 
connection.

2. On the product control panel, press the OK button.

3. Open the following menus:

● Service

● LaserJet Update

4. Scroll to the Check for Updates Now option, and press the OK button.

NOTE: The product automatically checks for an update, and if a newer version is detected, the update 
process automatically starts.

5. Set the product to automatically update the firmware when updates become available.

a. On the product control panel, press the OK button.

b. Open the following menus:

● Service

● LaserJet Update

● Manage Updates

c. Set the Allow Updates option to YES, and then set the Automatic Check option to ON. Press the OK 
button.

Method two: Update the firmware using the Firmware Update Utility
Use these steps to manually download and install the Firmware Update Utility from HP.com.

NOTE: This method is the only firmware update option available for products connected to the computer via 
a USB cable. It also works for products connected to a network.
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1. Go to www.hp.com/go/support, click the Drivers & Software link, type the product name in the search 
field, press the ENTER button, and then select the product from the list of search results.

2. Select the operating system.

3. Under the Firmware section, locate the Firmware Update Utility.

4. Click Download, click Run, and then click Run again.

5. When the utility launches, select the product from the drop-down list, and then click Send Firmware.

NOTE: To print a configuration page to verify the installed firmware version before or after the update 
process, click Print Config.

6. Follow the on-screen instructions to complete the installation, and then click the Exit button to close 
the utility.
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6 Solve problems

● Customer support

● Restore the factory-set defaults

● A “Cartridge is low” or “Cartridge is very low” message displays on the product control panel

● Product does not pick up paper or misfeeds

● Clear jams

● Improve print quality

● Solve wired network problems

● Solve wireless network problems

For more information:

Go to www.hp.com/support/ljM201, www.hp.com/support/ljM202.

HP's all-inclusive help for the product includes the following information:

● Install and configure

● Learn and use

● Solve problems

● Download software updates

● Join support forums

● Find warranty and regulatory information
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Customer support
Get telephone support for your country/region

Have the product name, serial number, date of purchase, and 
problem description ready.

Country/region phone numbers are on the flyer that was in the 
box with your product or at www.hp.com/support/.

Get 24-hour Internet support www.hp.com/support/ljM201, www.hp.com/support/ljM202

Download software utilities, drivers, and electronic information www.hp.com/support/ljM201, www.hp.com/support/ljM202

Order additional HP service or maintenance agreements www.hp.com/go/carepack

Register your product www.register.hp.com
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Restore the factory-set defaults
Restoring the factory-set defaults returns all of the product and network settings to the factory defaults. It 
will not reset the page count, tray size, or language. To restore the product to the factory-default settings, 
follow these steps.

CAUTION: Restoring the factory-set defaults returns all of the settings to the factory defaults, and it also 
deletes any pages that are stored in the memory. The procedure then automatically restarts the product.

1. On the product control panel, press the OK button to open the menus.

2. Open the following menus:

● Service

● Restore Defaults

The product automatically restarts.
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A “Cartridge is low” or “Cartridge is very low” message displays 
on the product control panel

Cartridge is low: The product indicates when a toner cartridge level is low. Actual toner cartridge life 
remaining may vary. Consider having a replacement available to install when print quality is no longer 
acceptable. The toner cartridge does not need to be replaced now.

Cartridge is very low: The product indicates when the toner cartridge level is very low. Actual toner cartridge 
life remaining may vary. Consider having a replacement available to install when print quality is no longer 
acceptable. The toner cartridge does not need to be replaced now unless the print quality is no longer 
acceptable.

Once an HP toner cartridge has reached Very Low, HP’s Premium Protection Warranty on that toner cartridge 
has ended.

Change the “Very Low” settings
Use the product control panel to change the way the product reacts when supplies reach the Very Low state. It 
is not necessary to re-establish these settings after installing a new toner cartridge.

1. On the product control panel, press the OK button.

2. Open the following menus:

● System Setup

● Supply Settings

● Black Cartridge

● Very Low Setting

3. Select one of the following options:

● Select the Stop option to set the product to stop printing when the cartridge reaches the Very Low 
threshold.

● Select the Prompt option to set the product to stop printing when the cartridge reaches the Very 
Low threshold. Acknowledge the prompt or replace the cartridge to resume printing.

● Select the Continue option to set the product to display an alert that the cartridge is very low, and 
to continue printing beyond the Very Low setting without interaction. This can result in 
unsatisfactory print quality.

Order supplies

Order supplies and paper www.hp.com/go/suresupply

Order through service or support providers Contact an HP-authorized service or support provider.

Order using the HP Embedded Web Server (EWS) To access, in a supported Web browser on your computer, enter 
the product IP address or host name in the address/URL field. The 
EWS contains a link to the HP SureSupply Web site, which provides 
options for purchasing Original HP supplies.
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Product does not pick up paper or misfeeds
● The product does not pick up paper

● The product picks up multiple sheets of paper

The product does not pick up paper
If the product does not pick up paper from the tray, try these solutions.

1. Open the product and remove any jammed sheets of paper.

2. Load the tray with the correct size of paper for your job.

3. Make sure the paper size and type are set correctly on the product control panel.

4. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the guides to 
the appropriate indentation in the tray.

5. Check the product control panel to see if the product is waiting for you to acknowledge a prompt to feed 
the paper manually. Load paper, and continue.

6. The rollers above the tray might be contaminated. Clean the rollers with a lint-free cloth dampened with 
warm water.

The product picks up multiple sheets of paper
If the product picks up multiple sheets of paper from the tray, try these solutions.

1. Remove the stack of paper from the tray and flex it, rotate it 180 degrees, and flip it over. Do not fan the 
paper. Return the stack of paper to the tray.

2. Use only paper that meets HP specifications for this product.

3. Use paper that is not wrinkled, folded, or damaged. If necessary, use paper from a different package.

4. Make sure the tray is not overfilled. If it is, remove the entire stack of paper from the tray, straighten the 
stack, and then return some of the paper to the tray.

5. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the guides to 
the appropriate indentation in the tray.

6. Make sure the printing environment is within recommended specifications.
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Clear jams
● Jam locations

● Experiencing frequent or recurring paper jams?

● Clear jams in the toner-cartridge area

● Clear jams in the output bin

● Clear jams in the duplexer (duplex models only)

Jam locations

1 2

1 Toner-cartridge area and output bin See Clear jams in the toner-cartridge area on page 58 and 
Clear jams in the output bin on page 60.

2 Duplex area (duplex models only) See Clear jams in the duplexer (duplex models only) 
on page 62.
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Experiencing frequent or recurring paper jams?
To reduce the number of paper jams, try these solutions.

1. Use only paper that meets HP specifications for this product.

2. Use paper that is not wrinkled, folded, or damaged. If necessary, use paper from a different package.

3. Use paper that has not previously been printed or copied on.

4. Make sure the tray is not overfilled. If it is, remove the entire stack of paper from the tray, straighten the 
stack, and then return some of the paper to the tray.

5. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the guides so 
they are touching the paper stack without bending it.

6. Make sure that the tray is fully inserted in the product.

7. If you are printing on heavy, embossed, or perforated paper, use the manual feed feature and feed 
sheets one at a time.

8. Verify that the tray is configured correctly for the paper type and size.

a. On the product control panel, press the OK button.

b. Open the following menus:

● System Setup

● Paper Setup

c. Verify the tray is configured for the paper type and size.

9. Make sure the printing environment is within recommended specifications.
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Clear jams in the toner-cartridge area
A Jam in cartridge area message displays on the product control panel.

1. Open the top cover.  

2. Remove the toner cartridge.  

3. Remove any jammed paper from the toner-
cartridge area. Use both hands to remove 
jammed paper to avoid tearing the paper.
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4. Reinsert the toner cartridge.  

5. Close the top cover.  

6. If the error message still displays on the control 
panel, press OK to clear it.
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Clear jams in the output bin
A Jam in output bin message displays on the product control panel.

1. Open the top cover.  

2. Pull out the green tab to release the jam-access 
cover.

 

3. Remove any jammed paper.  
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4. Close the jam-access cover.  

5. Close the top cover.  

6. If the error message still displays on the control 
panel, press OK to clear it.
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Clear jams in the duplexer (duplex models only)
A Jam in duplex area message displays on the product control panel.

1. Open the rear door.  

2. Remove any jammed paper from the duplex area. 
Use both hands to remove jammed paper to avoid 
tearing the paper.

 

3. Close the rear door.  

4. If the error message still displays on the control 
panel, press OK to clear it.

 

62 Chapter 6   Solve problems ENWW



Improve print quality
If the product is having print-quality problems, try the following solutions in the order presented to resolve 
the issue.

● Print from a different software program

● Check the paper-type setting for the print job

● Check the toner-cartridge status

● Print a cleaning page

● Visually inspect the toner cartridge for damage

● Check paper and the printing environment

● Check other print job settings

● Try a different print driver

Print from a different software program
Try printing from a different software program. If the page prints correctly, the problem is with the software 
program from which the page was printed.

Check the paper-type setting for the print job
Check the paper type setting when printing from a software program and the printed pages have smears, 
fuzzy or dark print, curled paper, scattered dots of toner, loose toner, or small areas of missing toner.

Check the paper type setting (Windows)

1. From the software program, select the Print option.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. From the Paper Type drop-down list, click the More... option.

5. Expand the list of Type is: options.

6. Expand the category of paper types that best describes your paper.

7. Select the option for the type of paper being used, and click the OK button.

8. Click the OK button to close the Document Properties dialog box. In the Print dialog box, click the OK 
button to print the job.

Check the paper type setting (OS X)

1. Click the File menu, and then click the Print option.

2. Select the product.

3. Click Show Details, and then click the Media & Quality menu or the Paper/Quality menu.
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4. Select a type from the Media-type drop-down list.

5. Click the Print button.

Check the toner-cartridge status
Check the supplies status page for the following information:

● Estimated percentage of cartridge life remaining

● Approximate pages remaining

● Part numbers for HP toner cartridges

● Number of pages printed

Use the following procedure to print the supplies status page:

1. On the product control panel, press the OK button.

2. Scroll to the Reports menu, and press the OK button.

3. Scroll to the Supplies Status option, and then press the OK button to print a report of the status of all 
supply items.

4. Check the percent of life remaining for the toner cartridge and if applicable, the status of other 
replaceable maintenance parts.

Print quality problems can occur when using a toner cartridge that is at its estimated end of life. The 
supplies status page indicates when a supply level is very low. After an HP supply has reached the very 
low threshold, HP’s premium protection warranty on that supply has ended.

The toner cartridge does not need to be replaced now unless the print quality is no longer acceptable. 
Consider having a replacement available to install when print quality is no longer acceptable.

If a toner cartridge or other replaceable maintenance part needs to be replaced, the supplies status 
page lists the genuine HP part numbers.

5. Check to see if a genuine HP cartridge is installed.

A genuine HP toner cartridge has the words “HP” on it, or has the HP logo on it. For more information on 
identifying HP cartridges go to www.hp.com/go/learnaboutsupplies.

HP cannot recommend the use of non-HP supplies, either new or remanufactured. Because they are not 
HP products, HP cannot influence their design or control their quality. If you are using a refilled or 
remanufactured toner cartridge and are not satisfied with the print quality, replace the toner cartridge 
with a genuine HP toner cartridge.

Print a cleaning page
During the printing process paper, toner, and dust particles can accumulate inside the product and can cause 
print-quality issues such as toner specks or spatter, smears, streaks, lines, or repeating marks.

Follow these steps to clean the product's paper path.
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1. On the product control panel, press the OK button.

2. Scroll to the Service menu, and press the OK button.

3. Scroll to the Cleaning Page option, and press the OK button.

A Cleaning message displays on the product control panel. The cleaning process takes a few minutes to 
complete. Do not turn the product off until the cleaning process has finished. When it is finished, discard 
the printed page.

Visually inspect the toner cartridge for damage
1. Remove the toner cartridge from the product, and verify that the sealing tape has been removed.

2. Check the memory chip for damage.

3. Examine the surface of the imaging drum on the toner cartridge.

CAUTION: Do not touch the roller (imaging drum) on the cartridge. Fingerprints on the imaging drum 
can cause print-quality problems.

4. If there are any scratches, fingerprints, or other damage on the imaging drum, replace the toner 
cartridge.

5. If the imaging drum does not appear to be damaged, rock the toner cartridge gently several times and 
reinstall it. Print a few pages to see if the problem has resolved.

Check paper and the printing environment

Step one: Use paper that meets HP specifications

Some print-quality problems arise from using paper that does not meet HP specifications.

● Always use a paper type and weight that this product supports.

● Use paper that is of good quality and free of cuts, nicks, tears, spots, loose particles, dust, wrinkles, 
voids, staples, and curled or bent edges.

● Use paper that has not been previously printed on.

● Use paper that does not contain metallic material, such as glitter.

● Use paper that is designed for use in laser printers. Do not use paper that is designed only for use in 
Inkjet printers.

● Use paper that is not too rough. Using smoother paper generally results in better print quality.

Step two: Check the environment

The environment can directly affect print quality and is a common cause for print-quality or paper-feeding 
issues. Try the following solutions:

● Move the product away from drafty locations, such as open windows or doors, or air-conditioning vents.

● Make sure the product is not exposed to temperatures or humidity outside of product specifications.

● Do not place the product in a confined space, such as a cabinet.
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● Place the product on a sturdy, level surface.

● Remove anything that is blocking the vents on the product. The product requires good air flow on all 
sides, including the top.

● Protect the product from airborne debris, dust, steam, grease, or other elements that can leave residue 
inside the product.

Check other print job settings
When printing from a software program, follow these steps to try to resolve the issue by adjusting other 
print-driver settings.

Check the EconoMode settings

HP does not recommend the full-time use of EconoMode. If EconoMode is used full-time, the toner supply 
might outlast the mechanical parts in the toner cartridge. If print quality begins to degrade and is no longer 
acceptable, consider replacing the toner cartridge.

NOTE: This feature is available with the PCL 6 print driver for Windows. If you are not using that driver, 
enable the feature by using the HP Embedded Web Server.

Follow these steps if the entire page is too dark or too light.

1. From the software program, select the Print option.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab, and locate the Print Quality area.

4. If the entire page is too dark, use these settings:

● Select the 600 dpi option.

● Select the EconoMode check box to enable it.

If the entire page is too light, use these settings:

● Select the FastRes 1200 option.

● Clear the EconoMode check box to disable it.

5. Click the OK button to close the Document Properties dialog box. In the Print dialog, click the OK button 
to print the job.
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Try a different print driver
Try a different print driver when printing from a software program and the printed pages have unexpected 
lines in graphics, missing text, missing graphics, incorrect formatting, or substituted fonts.

Download any of the following drivers from the HP Web site: www.hp.com/support/ljM201, www.hp.com/
support/ljM202.

HP PCL 6 driver ● Provided as the default driver on the product CD. This driver is automatically 
installed unless a different one is selected.

● Recommended for all Windows environments

● Provides the overall best speed, print quality, and product-feature support for most 
users

● Developed to align with the Windows Graphic Device Interface (GDI) for the best 
speed in Windows environments

● Might not be fully compatible with third-party and custom software programs that 
are based on PCL 5

HP UPD PS driver ● Recommended for printing with Adobe® software programs or with other highly 
graphics-intensive software programs

● Provides support for printing from postscript emulation needs, or for postscript 
flash font support

HP UPD PCL 5 ● Recommended for general office printing in Windows environments

● Compatible with previous PCL versions and older HP LaserJet products

● The best choice for printing from third-party or custom software programs

● The best choice when operating with mixed environments, which require the 
product to be set to PCL 5 (UNIX, Linux, mainframe)

● Designed for use in corporate Windows environments to provide a single driver for 
use with multiple product models

● Preferred when printing to multiple product models from a mobile Windows 
computer

HP UPD PCL 6 ● Recommended for printing in all Windows environments

● Provides the overall best speed, print quality, and printer feature support for most 
users

● Developed to align with Windows Graphic Device Interface (GDI) for best speed in 
Windows environments

● Might not be fully compatible with third-party and custom software programs that 
are based on PCL 5
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Solve wired network problems
Check the following items to verify that the product is communicating with the network. Before beginning, 
print a configuration page from the product control panel and locate the product IP address that is listed on 
this page.

● Poor physical connection

● The computer is using the incorrect IP address for the product

● The computer is unable to communicate with the product

● The product is using incorrect link and duplex settings for the network

● New software programs might be causing compatibility problems

● The computer or workstation might be set up incorrectly

● The product is disabled, or other network settings are incorrect

NOTE: HP does not support peer-to-peer networking, as the feature is a function of Microsoft operating 
systems and not of the HP print drivers. For more information, go to Microsoft at www.microsoft.com.

Poor physical connection
1. Verify that the product is attached to the correct network port using a cable of the correct length.

2. Verify that cable connections are secure.

3. Look at the network port connection on the back of the product, and verify that the amber activity light 
and the green link-status light are lit.

4. If the problem continues, try a different cable or port on the hub.

The computer is using the incorrect IP address for the product
1. Open the printer properties and click the Ports tab. Verify that the current IP address for the product is 

selected. The product IP address is listed on the product configuration page.

2. If you installed the product using the HP standard TCP/IP port, select the box labeled Always print to 
this printer, even if its IP address changes.

3. If you installed the product using a Microsoft standard TCP/IP port, use the hostname instead of the IP 
address.

4. If the IP address is correct, delete the product and then add it again.

The computer is unable to communicate with the product
1. Test network communication by pinging the network.

a. Open a command-line prompt on your computer.
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● For Windows, click Start, click Run, type cmd, and then press Enter.

● For OS X, go to Applications, then Utilities, and open Terminal.

b. Type ping followed by the IP address for your product.

c. If the window displays round-trip times, the network is working.

2. If the ping command failed, verify that the network hubs are on, and then verify that the network 
settings, the product, and the computer are all configured for the same network.

The product is using incorrect link and duplex settings for the network
HP recommends leaving these settings in automatic mode (the default setting). If you change these settings, 
you must also change them for your network.

New software programs might be causing compatibility problems
Verify that any new software programs are correctly installed and that they use the correct print driver.

The computer or workstation might be set up incorrectly
1. Check the network drivers, print drivers, and the network redirection settings.

2. Verify that the operating system is configured correctly.

The product is disabled, or other network settings are incorrect
1. Review the configuration page to check the status of the network protocol. Enable it if necessary.

2. Reconfigure the network settings if necessary.
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Solve wireless network problems
● Wireless connectivity checklist

● The product does not print after the wireless configuration completes

● The product does not print, and the computer has a third-party firewall installed

● The wireless connection does not work after moving the wireless router or product

● Cannot connect more computers to the wireless product

● The wireless product loses communication when connected to a VPN

● The network does not appear in the wireless networks list

● The wireless network is not functioning

● Perform a wireless network diagnostic test

● Reduce interference on a wireless network

Wireless connectivity checklist
● Verify that the network cable is not connected.

● Verify that the product and the wireless router are turned on and have power. Also make sure that the 
wireless radio in the product is turned on.

● Verify that the service set identifier (SSID) is correct. Print a configuration page to determine the SSID. If 
you are not sure the SSID is correct, run the wireless setup again.

● With secured networks, verify that the security information is correct. If the security information is 
incorrect, run the wireless setup again.

● If the wireless network is working correctly, try accessing other computers on the wireless network. If 
the network has Internet access, try connecting to the Internet over a wireless connection.

● Verify that the encryption method (AES or TKIP) is the same for the product as it is for the wireless 
access point (on networks using WPA security).

● Verify that the product is within the range of the wireless network. For most networks, the product must 
be within 30 m (100 ft) of the wireless access point (wireless router).

● Verify that obstacles do not block the wireless signal. Remove any large metal objects between the 
access point and the product. Make sure poles, walls, or support columns containing metal or concrete 
do not separate the product and wireless access point.

● Verify that the product is located away from electronic devices that might interfere with the wireless 
signal. Many devices can interfere with the wireless signal including motors, cordless phones, security 
system cameras, other wireless networks, and some Bluetooth devices.

● Verify that the print driver is installed on the computer.

● Verify that you have selected the correct printer port.

● Verify that the computer and product connect to the same wireless network.

● For OS X, verify that the wireless router supports Bonjour.
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The product does not print after the wireless configuration completes
1. Make sure that the product is turned on and in the ready state.

2. Turn off any third-party firewalls on your computer.

3. Make sure that the wireless network is working correctly.

4. Make sure that your computer is working correctly. If necessary, restart the computer.

5. Verify that you can open the product HP Embedded Web Server from a computer on the network.

The product does not print, and the computer has a third-party firewall installed
1. Update the firewall with the most recent update available from the manufacturer.

2. If programs request firewall access when you install the product or try to print, make sure you allow the 
programs to run.

3. Temporarily turn off the firewall, and then install the wireless product on the computer. Enable the 
firewall when you have completed the wireless installation.

The wireless connection does not work after moving the wireless router or product
1. Make sure that the router or product connects to the same network that your computer connects to.

2. Print a configuration page.

3. Compare the service set identifier (SSID) on the configuration page to the SSID in the printer 
configuration for the computer.

4. If the numbers are not the same, the devices are not connecting to the same network. Reconfigure the 
wireless setup for the product.

Cannot connect more computers to the wireless product
1. Make sure that the other computers are within the wireless range and that no obstacles block the signal. 

For most networks, the wireless range is within 30 m (100 ft) of the wireless access point.

2. Make sure that the product is turned on and in the ready state.

3. Turn off any third-party firewalls on your computer.

4. Make sure that the wireless network is working correctly.

5. Make sure that your computer is working correctly. If necessary, restart the computer.

The wireless product loses communication when connected to a VPN
● Typically, you cannot connect to a VPN and other networks at the same time.

The network does not appear in the wireless networks list
● Make sure the wireless router is turned on and has power.

● The network might be hidden. However, you can still connect to a hidden network.
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The wireless network is not functioning
1. Make sure that the network cable is not connected.

2. To verify if the network has lost communication, try connecting other devices to the network.

3. Test network communication by pinging the network.

a. Open a command-line prompt on your computer.

● For Windows, click Start, click Run, type cmd, and then press Enter.

● For OS X, go to Applications, then Utilities, and open Terminal.

b. Type ping followed by the router IP address.

c. If the window displays round-trip times, the network is working.

4. Make sure that the router or product connects to the same network that the computer connects to.

a. Print a configuration page.

b. Compare the service set identifier (SSID) on the configuration report to the SSID in the printer 
configuration for the computer.

c. If the numbers are not the same, the devices are not connecting to the same network. Reconfigure 
the wireless setup for the product.

Perform a wireless network diagnostic test
From the product control panel, you can run a diagnostic test that provides information about the wireless 
network settings.

1. On the product control panel, press the OK button.

2. Open the Self Diagnostics menu.

3. Select Run Wireless Test to start the test. The product prints a test page that shows test results.

Reduce interference on a wireless network
The following tips can reduce interference in a wireless network:

● Keep the wireless devices away from large metal objects, such as filing cabinets, and other 
electromagnetic devices, such as microwaves and cordless telephones. These objects can disrupt radio 
signals.

● Keep the wireless devices away from large masonry structures and other building structures. These 
objects can absorb radio waves and lower signal strength.

● Position the wireless router in a central location in line of sight with the wireless products on the 
network.
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